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1.  INTRODUCTION

Chapter 1 introduces the Smart Star embedded control system

and describes the features associated with the backplane chassis

and the CPU Card. The Tool Kit containing the hardware essen-

tials to begin using the Smart Star is described, and the software

highlights are presented.

The Smart Star is a modular and expandable embedded control system whose configuration 

of Digital I/O, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large 

variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a built-in voltage regulator, 

a CPU Card, and one or more I/O cards. The CPU Card plugs into a designated slot on the 

backplane chassis, which has additional slots available for any combination of I/O cards. 

A high-performance Rabbit 2000 microprocessor on the CPU Card operates at 22.1 MHz 

to provide fast data processing.

1.1  Features

• C-programmable to create a custom user interface

• Flexible functionality—modular configuration allows interchanging or replacing indi-
vidual I/O cards

• Expandable—up to 168 I/O ports

• Choice of two backplanes—with either 3 or 7 slots for I/O cards

• Choice of CPU cards—with or without one RJ-45 10/100-compatible Ethernet port 
with 10Base-T Ethernet interface

• RS-232 and RS-485 serial ports allow networking to other Smart Star units, single-
board computers, or enterprise computing centers

• 128K SRAM and 512K flash memory, optional 512K SRAM

• Real-time clock

• Watchdog supervisor

• Backup battery

• Optional backlit 122 × 32 graphic display/keypad module

• RabbitLink Ethernet gateway available for remote download/debug, Web serving, and 
e-mail
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Table 1 lists the backplanes, CPU cards, and the I/O cards that are available for the Smart 

Star control system. Appendix A provides detailed specifications for the Smart Star back-

planes and the CPU cards.

Table 1.  Smart Star Backplanes and Cards

Card Model Features

Backplane

SR9010
7 I/O card slots, 1 CPU card slot, header connections 

for optional LCD/keypad module

SR9050
3 I/O card slots, 1 CPU card slot, header connections 

for optional LCD/keypad module

CPU
SR9150 Full-featured CPU card with RJ-45 Ethernet port

SR9160 Full-featured CPU card without RJ-45 Ethernet port

I/
O

 C
ar

d
s

Digital I/O

SR9200 16 digital inputs, 8 digital sinking outputs

SR9210 8 digital inputs, 16 digital sinking outputs

SR9220 8 digital inputs, 8 digital sinking outputs

SR9205 16 digital inputs, 8 digital sourcing outputs

SR9215 8 digital inputs, 16 digital sourcing outputs

SR9225 8 digital inputs, 8 digital sourcing outputs

A/D Converter

SR9300 12-bit A/D converter, 11 channels, 0 V – 10 V

SR9310 12-bit A/D converter, 11 channels, -10 V – +10 V

SR9320 12-bit A/D converter, 11 channels, 4 mA – 20 mA

D/A Converter

SR9400 12-bit D/A converter, 8 channels, 0 V – 10 V

SR9410 12-bit D/A converter, 8 channels, -10 V – +10 V

SR9420 12-bit D/A converter, 8 channels, 4 mA – 20 mA

Relay
SR9500

5 SPST relays and 1 SPDT relay, each protected 

with onboard snubbers

SR9510 8 SPDT relays (no snubbers)
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1.2  User Connections

Connections to the I/O cards are made via a ribbon cable connector or optional field wir-

ing terminals that are either pluggable or have screw terminals. Three different Field Wir-

ing Terminals (FWTs) are available. Table 2 lists the I/O cards and the Rabbit part 

numbers for the corresponding FWTs.

NOTE:  Appendix A, “Field Wiring Terminals,” provides further information on FWTs, 

including their dimensions.

1.3  Optional Add-Ons

The LCD/keypad module is the only available optional add-on. Further details on the 

LCD/keypad module are provided in Appendix B.

Table 2.  Guide to FWT Selection

FWT Description I/O Cards

Rabbit Part Number

Pluggable Terminals Screw Terminals

FWT27
Digital I/O

Relay (SR9510)
101-0420 101-0514

FWT18
A/D Converter

D/A Converter
101-0421 101-0515

FWT18R Relay (SR9500) 101-0422 101-0516

Visit our Web site for up-to-date information about additional add-ons and features as 

they become available. The Web site also has the latest revision of this user’s manual.
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1.4  Development and Evaluation Tools

1.4.1  Tool Kit

The Tool Kit has the hardware essentials that you need to create and use your own Smart 

Star control system.

The items in the Tool Kit and their use are as follows:

• Smart Star (SR9000) Getting Started instructions.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Programming cable, used to connect your PC serial port to the Smart Star CPU Card to 

write and debug C programs that run on the Smart Star control system. 

• FWT27 pluggable field wiring terminal.

• Screwdriver.

• DC power supply, used to power the backplane, which in turn supplies power to the 

CPU card and the I/O cards.  The DC power supply accepts an AC input of 100 V to 

240 V at up to 0.6 A, and delivers a DC output up to 1.1 A at 24 V.

• Rabbit 2000 Processor Easy Reference poster.

• Registration card.

1.4.2  Software

The Smart Star control system is programmed using Rabbit’s Dynamic C. A compatible 

version is included on the Tool Kit CD-ROM.

Rabbit also offers add-on Dynamic C modules containing the popular µC/OS-II real-time 

operating system, as well as PPP, Advanced Encryption Standard (AES), and other select 

libraries. In addition to the Web-based technical support included at no extra charge, a 

one-year telephone-based technical support module is also available for purchase. Visit 

our Web site at www.rabbit.com or contact your Rabbit sales representative or authorized 

distributor for further information.
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1.5  CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30–230 MHz. The limits are 7 dB higher for frequencies 

above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based 

systems at frequencies above 300 MHz are generally well below background noise levels.

The CPU card, I/O cards, and backplane in the Smart Star embedded control system have 

been tested and were found to be in conformity with the following applicable immunity 

and emission standards as described in Table 3.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:

less than 40 dB µV/m at 10 m

(40 dB relative to 1 µV/m) or 300 µV/m

More restrictive emissions requirement:

30 dB µV/m at 10 m or 100 µV/m

Table 3.  CE Compliance of Smart Star Backplanes and Cards

Card Model Description

Used for CE 

Compliance 

Testing

Backplane

SR9010

7 I/O card slots, 1 CPU card slot, 

header connections for optional 

LCD/keypad module*

* No CE compliance testing was done with the LCD/keypad module connected to a Smart Star 

embedded control system. A system consisting of Smart Star boards and an LCD/keypad mod-

ule therefore cannot be considered to be CE-compliant. 

Full-featured ×

SR9050

3 I/O card slots, 1 CPU card slot, 

header connections for optional 

LCD/keypad module*

Sub-version

CPU
SR9150 22.1 MHz CPU card with Ethernet Full-featured ×

SR9160 22.1 MHz CPU card without Ethernet Sub-version

I/
O

 C
ar

d
s

Digital I/O

SR9200 16 inputs, 8 sinking outputs Full-featured ×

SR9205 16 inputs, 8 sourcing outputs Full-featured ×

SR9210 8 inputs, 16 sinking outputs Sub-version

SR9220 8 inputs, 8 sinking outputs Sub-version

A/D Converter

SR9300 Eleven 12-bit analog inputs (0–10 V) Sub-version

SR9310 Eleven 12-bit analog inputs (±10 V) Full-featured ×

SR9320 Eleven 12-bit analog inputs (4–20 mA) Sub-version

Relay
SR9500

5 SPST relays and 1 SPDT relay, each 

protected with onboard snubbers
Full-featured ×

SR9510 8 SPDT relays (no snubbers) Full-featured ×
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The sub-versions of the boards are also CE-compliant. All boards that 

are CE-compliant have the CE mark.

Several Smart Star boards are not yet CE-compliant. These boards are 

listed in Table 4.

Immunity

The CE-compliant Smart Star boards meet the following EN55024/1998 immunity standards.

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.

Emissions

The CE-compliant Smart Star boards meet the following emission standards when used 

with a Smart Star embedded control system that contains a Rev. C or higher version of the 

Rabbit 2000 microprocessor with its spectrum spreader turned on and set to the normal 

mode. This microprocessor is used in all Smart Star CPU boards that carry the CE mark.

• EN55022:1998 Class A

• FCC Part 15 Class A 

NOTE: The Smart Star embedded control system satisfied the Class A limits but not the 

Class B limits. Such equipment need not be restricted in its sale, but the following 

warning must be included in the instructions for its use.

Additional shielding or filtering may be needed to meet Class B emissions standards.

Table 4.  Smart Star Backplanes and Cards Not CE-Compliant

Card Model Description Comments

Backplane SR9000 7 I/O card slots, 1 CPU card slot Legacy product

CPU SR9100 25.8 MHz CPU card Legacy product

D/A Converter

SR9400 Eight analog outputs (0–10 V)

Passed emissions tests, 

immunity tests pending
SR9410 Eight analog outputs (±10 V)

SR9420 Eight analog outputs (4–20 mA)

Warning

This is a class A product. In a domestic environment this product may cause radio inter-

ference, in which case the user may be required to take adequate measures.
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1.5.1  Design Guidelines

Note the following requirements for incorporating a Smart Star embedded control system 

into your application to comply with CE requirements.

General

• The power supply provided with the Tool Kit is for development purposes only. It is the 

customer’s responsibility to provide a CE-compliant power supply for the end-product 

application.

• When connecting the Smart Star embedded control system to outdoor cables, the cus-

tomer is responsible for providing CE-approved surge/lighting protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a 

metal conduit to assist in maintaining CE compliance and to conform to good cable 

design practices.

• When installing or servicing the Smart Star embedded control system, it is the responsi-

bility of the end-user to use proper ESD precautions to prevent ESD damage to the 

Smart Star. 

Safety

• All inputs and outputs to and from the Smart Star embedded control system must not be 

connected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the CPU card in the Smart Star embedded control 

system has been designed to protect the battery from hazardous conditions such as 

reverse charging and excessive current flows. Do not disable the safety features of the 

design.

1.5.2  Interfacing the Smart Star to Other Devices

Since Smart Star embedded control systems are designed to be connected to other devices, 

good EMC practices should be followed to ensure compliance. CE compliance is ulti-

mately the responsibility of the integrator. Additional information, tips, and technical 

assistance are available from your authorized Rabbit distributor, and are also available on 

our Web site at www.rabbit.com.
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2.  GETTING STARTED

Chapter 2 explains how to connect the power supply to the

Smart Star backplane, how to install the CPU Card on the back-

plane, and how to connect the programming cable to the CPU

Card. Once you run a sample program to demonstrate that you

have connected everything correctly, you will be ready to go on

to install I/O cards and finish developing your system.



18 Smart Star (SR9000)

C
P

U
/B

A
C

K
P

L
A

N
E

2.1  Attach the CPU Card to the Backplane

1. Orient the backplane with the PROCESSOR SLOT facing away from you as shown in 

Figure 1.

Figure 1.  Attach the CPU Card to the Backplane

2. Position the CPU Card above the backplane as shown in Figure 1.

3. Carefully insert the CPU Card header into the PROCESSOR SLOT on the backplane 

and line up the facing edge of the CPU Card with the back edge of the alignment holes 

on the backplane as shown in Figure 1.

NOTE: Be careful to line up the pins on the CPU Card with the socket on the backplane when 

installing the CPU Card. The CPU Card can be damaged once power is applied if the CPU Card 

is not installed correctly.

4. Use the two 4-40 screws supplied with the CPU Card to anchor the plastic brackets so 

that they hold the CPU Card firmly in place on the backplane.
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2.2  Connect the Power Supply

Connect the power supply to the POWER IN 

connector on the backplane—the red (posi-

tive) wire to +RAW and the black (negative) 

wire to GND, as shown in Figure 2.

Figure 2.  Power Supply Connections

(North America)

NOTE: Be careful to hook up 

the positive and negative leads 

exactly as described. Only the 

+5 V circuitry is protected 

against reverse polarity.

A USER connection is supplied on the 

backplane to allow an independent power 

supply to be used for future development. 

For now, use a wire jumper to connect 

USER to +RAW so that they share the same 

power supply.

Notice to Customers 
Outside North America

The power supply included with the Smart Star 

Tool Kit may be used worldwide. Customers 

outside North America simply need to 

exchange the line cord and plug from the 

power supply to their wall outlet with one 

available locally.

1. To exchange the line cord and plug, first 

remove the existing line cord. To access the 

screws, use a screwdriver to gently lift up 

and remove the plastic insulating cover.

Figure 3.  Power Supply Connections 

(overseas)

2.Unscrew the wires at the ground, L, and N 

terminals.

3.Attach the line cord that you obtained locally 

to the power supply. Be sure to follow any 

color-coding conventions, for example, 

green/yellow to ground, brown to L, and 

blue to N terminals.

4.Ensure that the wires are attached securely 

and are not touching each other. Snap on 

the plastic insulating cover.

NOTE: The power supply included 

with the Smart Star Tool Kit is 

intended for development purposes 

only.
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2.3  Programming Cable Connections

1. Connect the programming cable to the CPU Card.

Connect the 10-pin PROG connector of the programming cable to header J2 on the CPU 

Card as shown in Figure 4. Connect the other end of the programming cable to a COM 

port on your PC. Note that COM1 on the PC is the default COM port in the Dynamic C 

installation.

NOTE: Be sure to use the programming cable (Part No. 101-0513) supplied with the 

Smart Star Tool Kit—the programming cable has red shrink wrap around the RS-232 

converter section located in the middle of the cable. Programming cables from other 

Rabbit kits are not designed to work with the Smart Star.

Figure 4.  Programming Cable Connections

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. 

Carefully pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use 

an RS-232/USB converter (Part No. 20-151-0178) with the programming cable sup-

plied with the Tool Kit. Note that not all RS-232/USB converters work with Dynamic C.
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2. Apply power.

Plug the power supply in to a nearby outlet. The CPU Card is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the power supply, then plug-

ging it back in.

To power down the SmartStar, unplug the power supply. You should disconnect power 

before making any circuit adjustments or changing any connections to the SmartStar.
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2.4  Installing Dynamic C

If you have not yet installed Dynamic C version 7.06P3 (or a later version), do so now by 

inserting the Dynamic C CD from the Smart Star Tool Kit in your PC’s CD-ROM drive. 

The CD will auto-install unless you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and 

browse for the setup.exe file on your CD drive. Click OK to begin the installation once 

you have selected the setup.exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, create a new desktop icon that points to default.htm in the 

docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of 

Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-

lation of the later version will be in a different folder, and a separate icon will appear on 

your desktop.
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2.5  Starting Dynamic C

Once the CPU Card is installed and connected as described above, start Dynamic C by 

double-clicking on the Dynamic C icon or by double-clicking on dcrab_XXXX.exe in the 

Dynamic C root directory, where XXXX are version-specific characters.

Dynamic C defaults to using the serial port on your PC that you specified during installa-

tion. If the port setting is correct, Dynamic C should detect the CPU Card and go through 

a sequence of steps to cold-boot the CPU Card and to compile the BIOS. (Some versions 

of Dynamic C will not do the initial BIOS compile and load until the first time you com-

pile a program.)

If you receive the message No Rabbit Processor Detected, the programming 

cable may be connected to the wrong COM port, a connection may be faulty, or the target 

system may not be powered up. First, check both ends of the programming cable to ensure 

that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C. 

From the Options menu, select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate the 

active COM port. You should receive a Bios compiled successfully message 

once this step is completed successfully. 

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging,  it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Communications 

menu. Choose a lower debug baud rate.
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2.6  PONG.C

You are now ready to test your set-up by running a sample program.

Find the file PONG.C, which is in the Dynamic C SAMPLES folder. To run the program, 

open it with the File menu (if it is not still open), compile it using the Compile menu, and 

then run it by selecting Run in the Run menu. The STDIO window will open and will dis-

play a small square bouncing around in a box.

This program does not test the serial ports on the CPU Card, but does ensure that the CPU 

is basically functional.
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2.7  Installing I/O Cards

1. Orient the backplane with the CPU Card already installed and facing towards you as 

shown in Figure 5.

Figure 5.  Installing I/O Cards on the Backplane

2. Position the new I/O card above the backplane over any unused slot position (SLOT 0 to 

SLOT 6) as shown in Figure 5. Note the slot number and the type of I/O card since 

Dynamic C addresses the I/O cards by slot number.

3. Carefully insert the I/O card header into the slot on the backplane and line up the tabs 

on the I/O cards with the slots on the backplane as shown in Figure 5.

4. Use the two 4-40 screws supplied with the I/O card to anchor the plastic brackets on the CPU 

Card or the I/O card firmly on the backplane. Tighten the screws as needed using a Phillips 

screwdriver whose shaft is at least 3" (7 cm) long, but is no thicker than 0.16" (4 mm).
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